Description

Simple Slab Deck

For LUSAS version: 20.0
For software product(s): | LUSAS Bridge.
With product option(s): | None.

Description

A simply supported bridge structure consisting of an in-situ slab deck is to be analysed.
The geometry of the deck is as shown. The slab has 0.5m thick carriageways and 0.4m
thick footways.
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The structure is subjected to loading defined in the Departmental Standard BD 37/88
Loads for Highway Bridges.

The units of the analysis are kN, m, t, s, C throughout.
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Modelling

Simple Slab Deck

Objectives
The required output from the analysis consists of:

U A deformed shape plot showing displacements caused by the imposed loading
O A diagram showing the bending moments in the slab

Keywords

3D Beam/Shell, Bridge Loading, Moving Load, Eccentricity, Basic Load
Combination, Load Envelope, Peak Values, Deformed Mesh, Contours, Graphing.

Associated Files
Associated files can be downloaded from the user area of the LUSAS website.

U bridge_slab_modelling.lvb carries out most of the modelling of the
example. After running the script go to the heading entitled Assigning the
Moving HB Vehicle Load and continue from this point.

Note. Model and results images included in this example were captured in an earlier
version and may differ in appearance from those seen and obtained from this version.

Running LUSAS Modeller

For details of how to run LUSAS Modeller, see the heading Running LUSAS
Modeller in the Introduction to LUSAS Worked Examples document.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File
> New to start a new model file. Modeller will prompt for any unsaved data and display
the New Model dialog.

Creating a new model

e Enter the file name as bridge_slab

e Use the Default working folder.

e Ensure an Analysis type of Structural is set.
e Set the Analysis category as 3D

e Change the model units to kN,m,t,s,C

e Ensure that timescale units are Seconds
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e Select the Startup template 3D Beam/Shell
e Ensure the Layout grid is set as None
e Enter the title as Simple Bridge Slab Analysis

e Click OK

The Attributes & treeview will be populated with potentially useful basic line mesh,
material, geometric and support entries appropriate to the settings made.

Note. An analysis category of 3D and a 3D Beam/Shell template is specified because
eccentricities will be defined that provide in-plane effects, which cannot be obtained
from a 2D model.

Note. Use the undo button to correct a mistake. The undo button allows any number
of actions since the last save to be undone.

Defining the Material

Ungraded concrete material is provided by the startup template.

e Select the Concrete (Ungraded | Concrete) attribute from the & Treeview with
the right-hand mouse button and select Set Default to make concrete the default
material for all newly created features.

Feature Geometry

il Enter coordinates of (0, 0), (10.5, 0) to define the lower Line. Use the Tab key to
move to the next entry field on the dialog. With all the coordinates entered click the
OK button.

e Select the line.
él Sweep the line through a translation of X=-1.5, Y= 1.5, Z = 0 and click OK to
create a Surface which defines the lower footway.

e Select the Line at the top of the footway.

&l Sweep the Line through a translation of X=-7, Y=7, Z= 0 and click OK to create
a Surface which defines the carriageway.

e Select the Line at the top of the carriageway.
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él Sweep the Line through a translation of X= -1.5, Y= 1.5, Z= 0 and click OK to
create a Surface which defines the upper footway.

Defining a Surface Mesh

A 3D Thick shell surface mesh is provided by the startup template. To assign the mesh
to the model all features must be selected:

o Select all the features of the model, (press the Ctrl and A keys at the same time).

e Drag and drop the Surface mesh attribute Thick shell, linear order from the P
Treeview onto the selected features.

The mesh will be displayed with each Line being split according to a default number of
divisions specified for each line.

Note. One way of controlling the mesh density is by specifying the number of mesh
divisions along each Line. Since Modeller is fully associative, this will control Surface
mesh density.

Using Line Mesh Divisions

In this example 8 divisions per Line are required for the longitudinal Lines and
transverse Line representing the carriageway. A number of Line mesh divisions are

defined by default. These can be seen in the &% Treeview.

e Select the 4 Select these 6
longitudinal Lines as Lines for

shown. Hold the Shift
key down after

selecting the first Line =N
to add the other Lines

to the selection. @
e Still holding the Shift \X‘YX\
key, select the 2

transverse Lines of the \%\
surface  representing
the carriageways. L >

e

'Divisions=8'

e Drag and drop the Line
mesh attribute Null, div = 8 from the & Treeview onto the selected features.

The mesh will be re-displayed to show 8 mesh divisions along each selected line.
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Note. Holding down the L key while selecting features ensures that only lines will be
selected. Similarly, the P key limits the selection to Points, the S key; Surfaces, the V
key; Volumes and the G key; Geometry. Similar shortcuts exist for elements, nodes,
etc., which can be found in the Online Help.

Defining the Slab Thickness and Eccentricity

The slab is 0.5 m thick in the carriageway region and 0.4 m thick beneath the footways.
e Enter a thickness of 0.5 and leave the eccentricity field empty.
e Enter the attribute name as Thickness 0.5

e Click the Apply button to define the first geometry attribute and allow another
dataset to be defined.

e Change the thickness to 0.4

Eccentricity measured Element local z axis

from mid surface of
0.4m thick slab to nodal
line in element local z
direction.

Nodal line at
Mid surface of slab antre of 0.5m
in footway region thick slab

Note. The direction of the eccentricity is measured from the mid-surface of the slab to
the nodal line in the local element direction which follows the local surface direction.
Since in this example the mid-surface of the slab representing the footway is above the
nodal line, and the element local Z axis direction is vertically up, the eccentricity is
input as negative.

e Enter the eccentricity as -0.05
e Change the attribute name to Thickness 0.4
e Click the OK button to finish.
The thickness is now assigned to each Surface.

e Select the central Surface representing the carriageway.
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e Drag and drop the geometry attribute Thickness 0.5 from the &% Treeview onto the
selected surface. Click OK to assign to the selected features for Analysis 1.

Geometric assignments are visualised by default.

e Select the outer two footway Surfaces, (hold down the Shift key to add the second
Surface to the selection).

e Drag and drop the geometry attribute Thickness 0.4 from the & Treeview onto the
selected surfaces. Click OK to assign to the selected features for Analysis 1.

El Select the isometric

button to see the geometric
visualisation on the
members.

El The Zoom in button

can be used to check the eccentricity has been assigned correctly.
@l Select the Home button to return the model to the default view.

ll Select the fleshing on/off button to turn-off the geometric visualisation

Supports

The more common types of support are provided in the &% Treeview by default. In this
example the slab deck is to be restrained in the vertical and lateral direction at the
abutment edges, Additionally, a single pinned support will be assigned to one point on
the deck to prevent rigid body motion.

Before the supports can be assigned a local coordinate system needs to be defined so
the lateral displacement can be restrained in the skew direction along the length of the
abutment edges.

e Enter an angle of 45 for the rotation about the Z-axis.

e Enter the dataset name as Skew and click OK to add the Local coordinate attribute
to the & Treeview.

By default the new Skew local coordinate system, is visualised within the view global
axes.

To assign the abutment supports:
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e Select the six Select these 6 Lines
transverse Lines « . @
representing the end
diaphragms (ensure the
Shift key is used to @

add to the initial \&\

selection)
e Drag and drop the w \Q
-~
local coordinate R i o—

attribute Skew onto the
selected Lines.

o Drag and drop the support attribute Fixed in YZ onto the selected Lines.
The Assign Support dialog will be displayed.
e Ensure that the attribute is assigned to All analysis loadcases

e Click the OK button to finish.

To assign the pinned

™ ey
support: = N
. . N .

e Select the single Point W .

at the origin \\ \\

N N

e Drag and drop the N e

support attribute \\ : \\

Pinned onto the Nt N,

b 9

selected Point. Select this Point \_W‘ * ~N

The Assign Support dialog will be displayed.
e Ensure that the attribute is assigned to All analysis loadcases

e Click the OK button to finish.

Note. Since the slab is flat the in-plane rotation degrees of freedom for the thick shell
elements can be eliminated from the element formulation by deselecting the following
element option. This will remove ill-conditioning of the equations and reduce the
problem size. It should however be noted that if moment supports are to be applied
with this option deselected, rotation about the Z axis must be restrained to eliminate
mechanisms in the solution.
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e Select the Options tab and select the Element Options button. Deselect the option
to Assign 6 DOF to all thick shell element nodes and click the OK button to
return to the Model Properties, Click OK to return to the display.

Defining the Loads

Four loadcases will be defined:

U The self-weight of the slab (ignoring any surfacing loads).

U A patch load equivalent to a traffic load over the full length and width of the
upper traffic lane.

U A knife edge load acting at mid-span of the upper lane.
O An HB vehicle in the lower lane.

Self-weight

The self-weight is defined using acceleration due to gravity in the negative Z direction.
A body force loading attribute representing gravity is provided by the startup template.
This will be assigned to the model shortly.

Lane Load

The second load will represent a lane load along the upper traffic lane.
e From the Vehicle Loading dialog select the Lane load (HA Load) button.
e Select loading code BD37/88 from the pull-down list.

o Enter the loaded length as 10.5, leave the notional width set as 3.5, set the skew
angle as -45 and the origin as Centre, then click OK to add the lane load patch

loading to the &% Treeview.

Note. Setting a skew angle on this patch load does not skew the whole load — it only
skews the ends of the patch load to match the angle of the skewed deck.

Knife Edge Load
e From the Vehicle Loading dialog select the Knife edge load (KEL load) button.

e Leave the skew angle as 0 and click OK to add the lane load patch loading to the
&% Treeview.
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Abnormal Loading

e From the Vehicle Loading | A4bnormalLoad (HE Vehicle) B8
dialog select the Abnormal ErEEEEEE
Load (HB Vehicle) button. B
Inner axle spacing (m) [ - 1"1‘ LN
25m{Tm
i LeaVe the AXIe SpaCIng as 6 Number of HB units (25 - 45) 450 Tm:

and the Number Of HB 18m[B1116,21.26 | 18m
units as 45 and click OK to

add the HB vehicle point ok ] [ Gomod |
load to the #%Treeview.

Apply H Help ‘

o Select Close to close the Vehicle Loading dialog.

Assigning the Self-weight Load

e To assign the gravity loading select all active features using the Ctrl + A keys

together and drag and drop the loading attribute Gravity vertical from the o
Treeview onto the selected features.

The Loading Assignment dialog
will be displayed.

e Ensure that the Assign to
Surfaces button is selected
and click the OK button to
assign the load to Analysis 1,
Loadcase 1.

The load visualisation for
Loadcase 1 will be displayed.

e To rename Loadcase 1 in the ‘! Treeview expand Analysis 1 and select Loadcase
1 with the right-hand mouse button, then choose the Rename option. Overtype the
loadcase name with the name Self Weight

Assigning the Lane Load and Knife Edge Loads

Vehicle and lane loads are represented by patch loads that are assigned to Points which
may form part of the model, or may be defined specifically to locate the bridge loads as
in this case:

El Enter coordinates as (-1.5, 6.75) and click the OK button to create a new Point in
the middle of the upper lane.
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e In the Treeview move the Geometry layer name down to sit beneath the
Attributes layer so that the point defined can be seen.

The patch and knife edge loads can now be assigned to the Point that has just been
defined.

o Select the Point defined at the centre of the upper traffic lane.

e Drag and drop the loading attribute Pch2 (HA BD37/88 10.5m x 3.5m Skew= -
45.0deg (Centre)) from the &% Treeview onto the selected Point.

The Loading Assignment dialog will | biseretePatch Lozding Assignment =
appear. Patch transformation
[No Attribute Selected -
The loading option to Project over area | ‘eduensbmaton
will have been automatically selected. JN";”‘”“‘“&‘“‘“ d
o Overtype the name of the loadcase to | == d
be HA & KEL upper (7 Project onto line (2D line beams and frames)
Ignore projection direction moments
(@) Project over area (grilages, shells, and 30 space frames)
e Click on the OK to complete the [¥]1gnore projecton moments
ass|gnment () Project into volume (solids)
Options for loads outside search area
; i 1ali analysi
The patch load will be visualised on the N ey -
m Ode I . Set as active loadcase
Load factor 1.0
l OK ][ Cancel ][ Help ]

Note. The number of patch load divisions in the patch is set in the % Patch divisions
object. By default ten patch divisions are used in the long direction of the patch. For
more detailed information on discrete point and patch loads refer to the on-line help.

e With the Point defined at the .
centre of the upper traffic lane ARG S
still selected, drag and drop the Nt 0SSN,

. . AN SN NN
loading attribute Pch3 (KEL \-\-\k\- e ¥ \\
120kN Width=3.5m Offset=0 Ny -
Skew=0.0deg (Centre)) from \\ \\
the &® Treeview onto the = N
A .

selected Point.

e Select the loadcase name HA & KEL upper from the loadcase drop down list and
click the OK button to assign the load.

The assigned patch loading for the upper lane should be as shown.

10



| Geometry
| Line >
| By Coords...
| Bridge

| Moving Load...

Modelling

Note. In this example the patch loading has been shaped to match the skew of the
deck, but it could have alternatively been defined oversize in length and when assigned
to the model any loading outside of the model could have been excluded as necessary.

If rebuilding a model or creating a model using the
supplied file.

If a previous analysis of this example has failed, you need to return to this point to
continue after having run the supplied file stated.

If you created the model using the supplied associated file, you need to continue from
this point to complete the modelling required.

Assigning the Moving HB Vehicle Load

The HB vehicle will be assigned to the points using the moving load generator. To use
this facility a line defining the path of the vehicle must be created.

e Click on a blank area of the model window to clear the current selection.

il Enter coordinates of (-3.25, 3.25) and (7.25, 3.25) to define a Line describing the
path of the HB vehicle and click OK.

o Select the Line just defined.
e Ensure the Moving vehicle load is set to Pnt4: (HB 6m spacing 45 units).

e Set the option Move vehicle along path in equal number of divisions to 10 and
click OK to generate loadcases 3 to 13 representing the HB load moving forward
across the bridge.

Checking loading = N

Loads on the model may be visually \\ \\

checked at any time by changing the \\ \\

active loadcase. NN N

NN LY

e From the (5 Treeview select \\: \:“ :\\
Load ID=4 Line=17 Dir=Fwd i .
Pos=6, click the right-hand N

mouse button and select the Set Active option to see the mid-span position of the
moving load.

11
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| save

This process may be repeated for any loadcase, and the isometric view button @I can
be used to rotate the model so the load directions can be seen.

Saving the Model

The model is now complete and the model data should be saved before running
analysis.

El Save the model file.

Running the Analysis

=

With the model loaded:

;l Press the Solve Now button to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful
Analysis loadcase results are added to the (2 Treeview.

In addition, 2 files will be created in the Associated Model Data directory:

U bridge_slab.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U bridge_slab.mys this is the LUSAS results file which is loaded
automatically into the (X Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully. You may
download this file from the user area of the LUSAS website.

12
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O bridge_slab_modelling.lvb carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as bridge_slab

e Use the default User-defined working folder.

e Ensure an Analysis category of 2D Inplane is set.
e Click the OK button.

Note. There is no need to enter any other new model details when a script is run to
build a model, since the contents of the script will overwrite any other settings made.

e To recreate the model, select the file bridge_slab_modelling.lvb that was
downloaded and placed in a folder of your choosing.

Now return to the section entitled Assigning the Moving HB Vehicle Load earlier in
this example and continue from this point.

Viewing the Results

[View
| Page Layout Mode

Loadcase results can be seen in the @ Treeview, and the loadcase results for the last
solved loadcase is set active by default.

The results will be examined. For this problem the following are required:

O A plot of the deformed mesh.

O A contour plot of bending moments in the X direction due to a load
combination.

O A graph showing the variation of bending moment along a section of the slab.

U A contour plot of Wood-Armer reinforcement moments in the slab.

Using Page Layout Mode

The model was created using a Working Mode view which allows a model of any size
to be created. Results could be viewed using this mode of operation, but in order to
allow additional information to be added without obscuring the model, Page Layout
Mode can be used instead.

The graphics window will resize to show the model on an A4 size piece of paper in
landscape orientation.

13
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e Ensure that left, right top and bottom margins are set to 60, 10, 10 and 10
respectively and click OK

Displaying the deformed shape

The deformed mesh layer initially provided in the [ Treeview by the startup template
is turned on following a successful solve of the model. To see just the deformed mesh
of the model the Mesh, Attributes and Geometry layers will be turned off.

o In the =" Treeview, click the right-hand mouse button on the Mesh entry and turn
off the Display option. The mesh layer will be hidden from the display.

¢ Repeat to turn off the Attributes and Geometry layers.

El If necessary, use the Isometric view button to rotate the model to the view
shown.

Set the active loadcase

e Inthe @ Treeview right-click on Self Weight and select the Set Active option.

Note. If ever required, the local
coordinate system axes can also
be turned off by deselecting the
Show Definition option for the

Skew entry in the & Treeview.

Saving a view
This page layout view can be saved for subsequent re-use with other models.

Enter the view name as Landscape Page Layout and click OK

Contour Plots

Results can be plotted as colour line or filled contour plots. Here, longitudinal bending
moments will be plotted as colour filled contours.

£ i Return the model to the default starting view by pressing the Z axis field
on the status bar at the bottom of the graphics window.

e With no features selected click the right-hand mouse button in a blank part of the

graphics window and select the Contours option to add the contours layer to the
Treeview.

14



Viewing the Results

The contours properties dialog will be displayed.

e Select Entity Force/Moment
Component moments in the X
direction Mx

e Click the OK button to display
contours of moments in the X
direction.

Note. By default in LUSAS Modeller, averaging of results is done for all situations
where it is appropriate. When it is inappropriate (as in this case where different
geometric thickness assignments have been made) no averaging of results across those
element boundaries takes place.

Moving information on the annotation layer

Text and other objects such as the contour key may be moved after their initial
placement.

e Click on one of the items of text on the contour key. (This will select the key and
enable it to be moved).

¢ Click and drag the object to a new position on the left-hand margin of the page.

Marking Peak Values

e With nothing selected click the right-hand mouse button in a blank part of the

graphics window and select the Values option to add the values layer to the
Treeview.

The values properties dialog will be displayed.

e Select Force/Moment contour results of bending moment Mx

e On the same dialog, select the Values Display tab and ensure the Maxima and
Minima check boxes are selected to display the top 1% of results.

e Set the number of significant figures to 4
e Change the angle to 45 degrees

e Select the Choose Font button and set the text size to 16 and click OK
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e Click the OK button to add the
peak values to the display. =

The contour layer can be turned
off and then on again to view the
values.

Defining an Envelope

Envelopes are used to show the
worst effect from a selection of
loadcases, combinations, or other envelopes. In this example an envelope is to be
assembled to show the worst effect from the moving HB vehicle.

To include just the moving load loadcases in the envelope:

e With Analysis 1 expanded in the Available list, select (3) Load ID=4 Line 17
Dir=Fwd Pos=1 from the loadcase panel. To select all HB moving loadcases hold
down the Shift key, scroll down the list and select (13) Load ID=4 Line 17

Dir=Fwd Pos=11 and click on the LI button to add all the selected datasets to
the Included panel.

e Change the name to Moving load lower and click OK

e Two envelope entries representing the maximum and minimum results will be
created in the tZ! Treeview.

Note. Changing the properties of the max or min envelope will change the definition
of both envelopes.

Defining a Combination

Combinations can be used to view the combined effects of several results loadcases,
combinations or envelopes.

The combination properties dialog will appear. Loadcases Self Weight, HA & KEL
upper and the moving load envelope are to be included in the combination.

e With Analysis 1 expanded in the Available list select both Self Weight and HA &

KEL upper from the Name panel and click the LI button to add the loadcases to
the combination dataset with a factor of 1

16



Viewing the Results

e With Post processing expanded in the Available list select the envelope Moving
load lower (Max) and click the LI button to add the loadcase to the combination
dataset

Note. By default loadcases are added to the combination with a factor of 1. This
factor may be changed by selecting the loadcase in the Included panel and changing the
load factor in the grid provided.

e Change the combination name to Max Design Combination and click the OK
button to finish.

Note. To obtain the correct effect from the combined loads the combination should

only include one occurrence of each loadcase. Envelope and Combination definitions
are held and saved within the model file.

Selecting and Viewing the Combination Results

o In the & Treeview right-click on Max Design Combination and select the Set
Active option.

e Select Force/Moment results of component Mx and click OK

Note. When a combination includes an envelope the deformed mesh layer is not
available.

The contour plot for Mx from the
load combination will be
displayed.

Note. The values layer is still
listed in the Treeview so the
maximum and minimum values
of Mx for the load combination
will also be shown.

Graphing the Results
of a Slice

A graph is to be plotted showing the variation in bending moment through a specified
section of the slab.

17
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If the model is being viewed in
the XY plane (as it is) the By
Cursor option will be selected
and the Snap to grid option will
be available.

e Ensure that Snap to grid is
selected with a grid size of 1

e Click the OK button.

e Click and drag the cursor along the centre of the lower lane (Y=3) to define the
location of a section slice through the slab.

Note. The Y ordinate of the slice can be seen in the status bar /T3 . The X
and Y scales on the sides of the window will also help this selection.

The graph X axis values of distance through the deck are defined by the slice section.
The graph Y axis results now need to be specified on the slice data dialog.

e On the Loadcases and Extent dialog ensure that Max design Combination is
selected and click Next.

e On the Slice Data dialog select Force/Moment results for Bending Moment in the
X direction Mx and click the Next button.

The graph Y axis results have now been defined and title information for the graph can
be added.

e Enter the graph title as Bending
Moment Mx along lower lane

e lLeave the graph X and Y axis
names blank. °

e Click the Finish button to display i
the graph.

Note. If the graph axes labels are
left unspecified default names will be
used. The graph properties can be modified by clicking the right hand mouse button in
the graph window and selecting the Edit Graph Properties option.

Desigr Comsmation()/ Cocedinstes (43,0} 10 {10,301

E Close the graph window.
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il Click on the selection mode button to return to normal cursor mode.

Save the model

El Save the model file.

Note. When the model file is saved after results processing, all load combinations,

envelopes, and graph datasets, if defined, are also saved and therefore do not have to be
re-created if the model is amended and a re-analysis is done at a later date.

This completes the example.

Use of an irregular mesh and transformation of results

In this example the geometry and mesh attributes result in a regular mesh aligned to the
global axis.

Caution. The use of an irregular mesh would mean that the results obtained would
have different orientations over the whole slab and hence be incorrect. In this
circumstance a local coordinate set would need to be used to orientate the element
results to be consistent with the global axes in order to obtain sensible components for
use in the calculations.

e A local coordinate set can be created by selecting Attributes > Local Coordinate.

e The mesh orientation can be viewed from the Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply
changes.

e Results transformations can be applied by visiting a results layer’s properties dialog
and pressing the Set... button.
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